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QuickView について 

Tap In Management Server は、Tap In Systems の製品の中核であり、種々のネットワーク、システム

およびアプリケーションにわたる監視と制御を提供します。このサービスは、メディエータとコンシュ

ーマのスクリプトのためのプログラミング拡張を含む Amazon の Web サービスサーバーインスタン

スです。また、さまざまなコンポーネント間の通信を、定義された IP ソケットプロトコルを使って仲

介します。自動化、対比およびクライアントアプリケーションは、イベント情報を共有するためにこの

プロトコルを使用します。メディエータとコンシューマの自動化アプリケーションは、管理サーバや 
Tap In エージェントとして、リモートシステム同じプラットフォーム上で実行できます。管理サーバは、

他の管理サーバや Tap In クライアントへのコネクションをサポートします。 

QuickView はTap In 管理サーバのクライアントで、あなたの管理サーバ上のすべてのオープン中イベン

トを見ることができる高性能のコンソールです。 QuickView は、管理サーバがイベントを処理するた

びにダイナミックにアラームを更新します。アラーム情報はカラーコード化されたテキスト形式で表示

します。アラームはオペレータの要求に従って、フィルターやソート処理されるかもしれません。 
QuickView は、Java ベースのアプリケーションで、ほとんどの Windows、Linux、UNIX や SUN オペ

レーティングシステムなど、Java をサポートするどのようなプラットフォーム上でも動作します。 

図: Tap In Systems - QuickView コンソールアプリケーション  
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QuickView のインストール 

QuickView プログラムは、同時には一台の Tap In 管理サーバ上と一緒に動作します。しかし、 複数の

QuickView インスタンスを、それぞれ別のTap In 管理サーバと接続して稼動させることができるでしょ

う。 

前提条件 

 オペレーティングシステム - QuickView は、通常 Windows やLinux システム上にインストール

される Java クライアントアプリケーションです。 

 Java - QuickView は Java クライアントアプリケーションで、Java version 1.6 以降のインスト

ールを要求します。 

 Tap In 管理サーバ - QuickView は実行中の Tap In 管理サーバ上への正当なログインでのアクセ

スを要求します。管理サーバ上での QuickView ユーザーの定義に関連する情報は Tap In 
Systems Administrator Guide を参照してください。 

 ブラウザ – Firefox version 3.0 か Internet Explorer version 7. 

Java のダウンロードとインストール 

 適切なオペレーティングシステムのための Java をダウンロードしてインストールするため、 

Java サイトhttp://www.java.com/en/download/manual.jsp に行きます。 

QuickView のダウンロードとインストール 

下記の手順に従って、Windows や Linuxのための QuickView をダウンロードし、インストールします： 

Windows 

1. ダウンロード – ブラウザで Tap In の Web サイト http://www.tapinsystems.com/ navigate 
を開き、Resources、Downloads ページにナビゲートして、QuickView Console for Windowns 
download のリンクをクリックします。  

2. インストール – Windows パッケージは MSI files として提供されます。ダウンロードし

た .msi ファイルをクリックすると、インストール手続きのプロンプトが表示されます。 

Linux 

3. ダウンロード – ブラウザで Tap In の Web サイト http://www.tapinsystems.com/ navigate 
を開き、Resources、Downloads ページにナビゲートして、QuickView Console for Linux 
download のリンクをクリックします。  

4. インストール – Linux パッケージは tar ファイルとして提供されます。ダウンロードした .tar 
ファイルを Untar します。 

図: Tap In Systems – ダウンロード 
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QuickView の起動 

Windows や Linux の QuickView を起動するには、下記の手順に従ってください： 

 Windows – インストール後にデスクトップに表示される  Tap In QuickView アイコンを

クリックします。 

 Linux – 下記のコマンドで Java プログラムを直接呼出します。必ず、Jar ファイルと同じディレ

クトリからコマンドを実行してください。 また、構成 XML ファイルが最後のパラメータとして

参照されることに注意してください。異なる構成ファイルを使いたい場合、このコマンドライン

内のファイル名リファレンスを変更してください。 

start javaw -classpath .¥WmiProxy.jar;.¥axis.jar;.¥jaxrpc.jar;.¥js.jar;.¥jdom.jar;.¥hsqldb.jar;. 

¥servletapi. jar;.¥spark-1.2.jar com.spiderweb.quickview.Gui qvdefault_default.xml 

QuickView のログインダイアログ 

QuickView の起動後、ログインのダイアログボックスが表示されます。後述の設定を入力し、OK をク

リックすると、QuickView が起動して Tap In 管理サーバに接続します。Tap In 管理サーバへの接続が

失敗した場合、エラーメッセージのダイアログボックスが表示されるでしょう。通常、指定されたマシ

ン上でサーバが稼動していないか、あなたが誤ったホスト名、ユーザ名やパスワードを使用したことを

意味します。 

 Conf file – これは、あなたがオープンするセッションのためのパラメータを含む構成ファイルです。 
Browse を選んで Conf サブティレクトリにナビゲートし、qv_default.xml ファイルを選んでく

ださい。 QuickView に慣れたら、自分自身のデフォルトセッションパラメータをセットするた

めにこのファイルを編集できます。本ドキュメントの QuickView スタートアップの自動化 を参

照してください。 

 Host – これは管理サーバです。 あなたがスタートさせた管理サーバ（例. test6.tapinsystems.net）
のホスト名を入力します。 

 Username と Password – 管理サーバのセットアップ手順内で、Consumer（コンシューマ）ユー

ザとして定義した、ユーザ名（Username）とパスワード（Password）を入力します。これらの

設定を変更していない場合、デフォルト値 peter とpeter が使用できます。 

図: QuickView のLogin ダイアログボックス 

 

 

 

 

 

 

 

QuickView の停止 

QuickView アプリケーションを停止するには、メニューバーから File、Logout を選びか、アプリケー

ションのウィンドウの右上端にある “X” をクリックして QuickView のウィンドウを閉じます。 

             ©2009                          Page 5 of 13 



Tap In Systems – QuickView ユーザガイド 

QuickView のオペレーション 

QuickView のメインウィンドウ 

起動したら、QuickView プログラムはウィンドウを生成し、あなたが接続した Tap In 管理サーバから

のイベントを表示します。通常の QuickView Console（コンソール）の見え方は下記のようになります。 

図: QuickView コンソールのメインウィンドウ 

 

 タイトルバー 

タイトルバーは SSL コネクションが使用されているかどうかと、ユーザ名および Tap In 管理

サーバのホスト名を表示します。 

 メニューバーとアクションバー 

メニューバーとアクションツールバーは、ウィンドウ上部の位置にあります。 

 イベントリストとスクローリング 

イベントリストはすべてのオープン中イベントを表示します。QuickView コンソール内の各イベ

ントは、画面内に水平方向で表示されます。各イベントは複数の属性を持ちます。属性はコンソ

ールウィンドウ上のカラムを構成します。初期コンソールのフィールドは、構成 XML でそれら

の表示を定義された順序で表示されます。ウィンドウの底部と右側にあるスクロールバーを使っ

て、上下、左右にスクロールすることができます。 

 カラムのソート、幅と位置 

カラムのタイトルをクリックすることで、イベント表示のカラムをソート（昇順、降順）できま

す。フィールド幅を変えるには、フィールドを分けているラインをドラッグします。また、フィ

ールドを望む順番にドラッグ＆ドロップすることで、フィールドの順番を変えることができます。  

 イベントサマリーとフィルター名 

ウィンドウの底部に表示されるサマリーは、重大度毎のイベントの総数を表示します。また、使

用されていれば、このエリアにフィルター名がリストされます。 
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スクロール、ソートとイベント選択 

スクロール – 一般的に、QuickView ウィンドウ内には、画面上に表示できる以上の情報がありま

す。あるイベントのすべての属性を参照するには、水平方向のスクロールバーを使ってください。

ウィンドウに表示されている以外の他のイベントを見るには、垂直方向のスクロールバーを使っ

てください。 

ソート – ヘッダ行内のフィールド名上を左クリックすることで、どのイベントフィールドでも、

ソートします。 

イベント選択 – ユーザは、最初に、ひとつか複数のイベントを選択してからアクションを選択す

ることで、イベントへのアクションを行うことができます。選択されたイベントがグレーに変わ

って、ウィンドウが停ります。あるイベントの上をクリックし複数のイベントの上をドラッグす

る、あるいは、あるイベントをクリックしCTLを押しながら追加イベントを選択することで特定

のイベント群を選びます。 

QuickView のアクションバー 

アクション 説 明 

 

全イベントの選択／非選択 – アラームが選択されていない場合、これは QuickView ウィンド

ウ内の全イベントを選択し、ウィンドウをフリーズします。アラームが選択されていれば、すべ

てのアラームを非選択にします。 

 

選択したアラームのクローズ – アクティブなイベントリストからイベントを削除します。その

イベントは他の QuickView ユーザとコンシューマアプリケーションについてクリアされます。

 

イベントのオーナシップ受け入れ – あるユーザが選択したイベントのオーナーになることを示

します。この機能は、複数ユーザがどの問題が調査中でどれがそうでないかを分かるようにしま

す。イベントを選択して Assign を選んだ後、ユーザIDが入るのがこのフィールドです。  

 

移管する – イベントのオーナシップを他のユーザに移します。イベントを選択して Route To 

を選んだ後、ユーザ（コンシューマ）のリストが表示されます。それらのユーザのひとつを選び

と Route To フィールドにそのユーザIDが入り、そのユーザに移管されたのが分かります。その

ユーザを承認するために Assign を選ぶと、それにより Route Toフィールドはクリアされます。

 

表示再開（レジューム） – このアイコンが選択されたら、コンソールの更新が有効になります。

表示の停止アイコンが選ばれるとブリンクします。 QuickView ウィンドウは、“アクティブ” (レ

ジューム) 状態か“フリーズ” (停止)状態のどちらかです。アクティブ状態の場合、Tap In 管理サ

ーバによって処理された新しいイベントは自動的に更新されます。しかし、イベントを調べるた

めには、QuickView ユーザは、ウィンドウをフリーズしたい場合があるかもしれません。 

 

表示停止 – メニュー化やアクションバーから Stop オプションを選ぶと、これが行えます。ウ

ィンドウがフリーズ状態の場合、表示停止アイコンはフラッシュします。レジュームアイコンを

クリックすると、ウィンドウはアクティブ状態に復帰し、キューイングされたすべてのイベント

が更新され、アイコンはフラッシュしなくなります。 

 

再同期 – 強制的に最新のアクティブイベントを Tap In 管理サーバから QuickView に送らせ

ます。通常、QuickView.には新しいイベントしか送られません。このオプションはQuickView 内

のオープン中イベントリストをサーバから送られてきた現在情報で置き換えます。なんらかの原

因でQuickView 画面が壊れた場合、File/Refresh メニューを選ぶだけで、表示が再描画されます。

 

調査 – イベントをダブルクリックすることで、単一イベントの詳細すべてを参照します。複数

のイベントを選択して、調査アイコンを選ぶと、次へ／戻る ボタン( “>>>” と “<<<”) が使える

ようになり、次や前のイベントへページを移動することができます。このダイアログボックスを

使って、フィールド値を他のアプリケーションにコピー＆ペーストすることも可能です。 

 

SQL フィルターをセット – コンソールのイベントリストに適用するフィルターを定義します。

詳しい手順については、後述の コンソールフィルターの定義 を参照ください。 
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QuickView メニューバー 

さまざまのアクションが QuickView メニューバーからもアクセスできます。下表でメニューバーから

のみアクセスできる他のアクションをリストします。 

オプション 説 明 

File>Login Login – このオプションは、ログアウトしているときのみ有効です。このオプションは Login 

ダイアログボックスを表示します。 

File>Logout Logout - ログインしているときのみ有効です。これは QuickView から Tap In 管理サーバ

をディスコネクトしますが、QuickView は動いています。 ここで、別のTap In 管理サーバ

にログインすることができます。 File、Log Out の選択やウィンドウを閉じるだけのログア

ウトをします。 

File>Print Print – メニューバーからアクセスします。このオプションはイベントリストをプリンターに

送ったり、ファイルに保存したりします。 

File>Close Close – メニューバーからアクセスし、QuickView ウィンドウとプログラムを閉じます。 

Help Help - Tap In System の Webサイトの QuickView ヘルプページをブラウザで開きます。 

Help>About About - QuickView バージョンを表示するウィンドウを開きます。 

コンソールフィルターの定義 

Filter オプションで、オープン中イベントのリストをフィルターし、たとえば重大度１のイベントのみ
の表示など、SQL select コマンドに適合したイベントを表示することができます。 

1.  アクションアイコン  を選ぶか、 Custom>Filter メニューオプションを選びます。Set SQL 
Fillter ダイアログボックスが表示されるでしょう。 

2.  Builder の横の “+” サインを選び、正しい SQL ステートメントを作成します。 

3. “+” の上のセル内を個別にクリックし、ドロップダウンリストからフィルターのクライテリアを選

択します。たとえば下図では、フィールド: SEVERITY、オペレータ: “=”、および 一致する重要

度（Severity）は “1” です。 また、フィールド名と条件を知っていれば、 SQL 条件を直接 Filter 
セクションに書き入れることもできます。 

複数条件を作成するには、Builder の “+” サインを再度選択します。 AND や OR オペレータが

複雑な SQL 条件を構築するのに使用できます。LIKE や IN を含む、完全な SQL シンタック

スがサポートされます。 

4.  SQL 条件が定義されたら、Filter エリアを埋めるために Copy を選びます。 

図: Set SQL Filter ダイアログボックス 
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5.  次に、Apply を選ぶと、イベントウィンドウにはセットされた Filter の条件にマッチしたアラー

ムが表示されるでしょう。そのフィルターの詳細は、イベントウィンドウの底部に表示されます。 

図: フィルター結果 

 

 

6.  一度 SQL 定義を定義したら、Save 選択で保存し、保存したフィルターを別の時に呼び出すこ

とができます。保存されたフィルターを使うには、このダイアログボックスを開いて Browse を

選び、保存したフィルターを選択します。 

図: 保存されたフィルターを開く 
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QuickView デフォルトセッティングの構成設定 

構成 XML 

QuickView は、コネクションと表示パラメータをセットするのに構成ファイルを使用します。この構成

XML ファイルを編集することで、あなたのデフォルト QuickView セッティングを作成できます。 

qv_default.xmlのセッティング例と説明: 

<QUICKVIEW 
debug="none"     # Setting ON displays additional messages to the console. 
Host=""     # Hostname of the Tap In Management Server 
username=""     # Username defined on the Tap In Management Server 
password=""     # Username's password defined on the server 
sev1color="255"    # Override the display color settings for severities. 
Sev2color="32767"   # Can be specified as decimal or hex if preceded by numbers. 
sev3color="65535"    # Are justified left. Example:“255”,“#FF”, and “#FF0000” all 
sev4color="16776960"    # represent the color red. 
sev5color="597"> 
<SSL keyStore="C:¥¥tapinsystems¥¥spider.bin"  # If SSL option is used, this is the location of the 

keyStorePassword="spideradmin"/>         # SSL certificate. If SSL is not used, delete this line. 
<LOG stdout="C:/stdout.txt"    # Log file output files. 

stderr="c:/stdout.txt"/> 
<COLUMNS>    # Define the event columns to display, order and width. 

<ID width="80"/>    # ID - The event’s unique identifier 
<ASTO width="0"/>    # Assigned To – ID of the consumer accepting ownership 
<RTTO width="0"/>    # Route To – ID of the consumer event is routed to 
<SEVERITY width="80"/>   # Severity – The severity of an event 
<PRIORITY width="80"/>   # Priority of an event 
<COUNT width="80"/>    # Count – The number of redundant events 
<FIRST width="120"/>    # First Time – Creation time of this event 
<LAST width="120"/>    # Last Time – Last time this event was updated 
<CLASS width="100"/>   # Class – A class designation assigned by the server 
<GROUPING width="200"/>   # Group – A group designation assigned by the server 
<EMS width="80"/>    # EMS – The category of the event 
<RULE width="100"/>    # Rule – The rule name generating an event 
<T1 width="0"/>    # T1/N1-T3/N3 – Unique identifier for an event based 
<N1 width="200"/>    # on the HRL fields in the form of T1:N1, T2:N2, T3:N3. 
<T2 width="0"/> 
<N2 width="150"/> 
<T3 width="0"/> 
<N3 width="150"/> 
<MESSAGE justify="left" width="800"/>     # Text message associated with an event 
<STAT width="0"/>    # Status of the event - assigned, accumulates, times out, etc. 
<GA width="0"/>    # Graph Attribute – Attribute name associated with an event 
<GV width="0"/>    # Graph Value – Attribute values associated with an event 

</COLUMNS> 
<SPARKLINE type="line" title="SEV1" limit="60">  # Define the event-input-rate graph displayed on the bottom 
</SPARKLINE> # of the QuickView window. 
<SPARKLINE type="line" title="SEV2" limit="60">  # Valid types are line and bar. 
<SPARKLINE type="line" title="SEV3" limit="60">.  # Limit shows the last number of incoming events to include 
</SPARKLINE> # in the graph. 
</SPARKLINE> 
<SPARKLINE type="line" title="SEV4" limit="60"> 
</SPARKLINE> 
<SPARKLINE type="line" title="SEV5" limit="60"> 
</SPARKLINE> 
</QUICKVIEW> 
 
 

             ©2009                          Page 10 of 13 



Tap In Systems – QuickView ユーザガイド 

QuickView スタートアップの自動化 

QuickView とTap In 管理サーバに、クリックひとつで自動的に接続することができます。この自動化プ

ロセスは、通常、ホスト情報とログイン認証を要求する Login ダイアログボックスを回避してコンソー

ルを立ち上げます。 このプロセスは、構成 .xml ファイル内で定義されたホスト名、ユーザ名とパスワ

ード設定へのリファレンスを含むコマンド（ないし Windows のバッチファイル）を取り込み、定義さ

れたホストに接続します。下記の手順に従い、あなたの構成ファイルを編集して、QuickView を起動し

てください。 

スタートアップ時に、これらの設定を手動で投入したい場合、構成ファイルの設定をブランクにしたま

まで、それらをログインダイアログボックスに入力してください。 これらのパラメータをダイアログボ

ックスに入力すると、右の設定を上書きします：ホスト、ユーザ名、パスワード。 

1.  まず、構成 .xml ファイル内で定義されている ホスト、ユーザ名とパスワード設定を入手します。 

<QUICKVIEW 

debug="none" 

host="testebs.tapinsystems.net" # Hostname of the Tap In Management Server 

username="peter" # Username defined on the Tap In Management Server 

password="peter" # Username's password defined on the Tap In Management Server 

2.  次に、コマンドプロンプトのウィンドウを開き、下記のコマンド（コーテーションと一緒に、一

行で）を実行します。 あるいは、簡便のため、下記のコマンドを含むバッチファイルを作成して、

そのバッチファイルへのショートカットをデスクトップに置くと良いでしょう。 

“C:¥Program Files¥Tap In Systems¥QuickView¥quickview.exe” 
“C:¥Program Files¥Tap In Systems¥QuickView¥conf¥qv_default.xml” 

3.  コマンドラインを投入するか、バッチファイルを実行すると、構成ファイルで指定したホスト 

(例. qv_default.xml)への QuickView が開きます。 
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用語集 
この表は、Tap In アプリケーションに関連する用語を説明します。 

Alarm  
（アラーム） 

Tap In 管理サーバシステムが表出してQuickView や Tap In Web ビューアで表示さ

れる、実世界の状況を表す抽象的な断面情報。 アラームは、sverity、priority、text 
messageと ID 番号などの識別アトリビュートを持ちます。アラームは、用語「イベ

ント」と相互に置き換えて使用できます。 

Attributes:  
（アトリビュート） 

アトリビュートは、各 Tap In 管理サーバのイベントを含む、抽象エレメントです。

アトリビュートには下記が含まれます： 

EMS Element Management System.（エレメント管理システム）のホスト名。 このフィールドは、ア

ラームのソースを示し、Tap In 管理サーバのよってそのホスト名が入れられます。 

(例、ip-10-251-210-132.ec2.internal). 

CLASS Tap In 管理サーバによって割り当てられたユーザ定義可能なクラス指定で、一般的には管理対

象機器のカテゴリ（例. All、QVC、Spide,、TIS_EC2_Linux_Agent）をセットします。たとえば、

Linux エージェントから来た全イベントに対し Linux_Agent クラスが指定されるでしょう。 

GROUP Tap In 管理サーバによって割り当てられたユーザ定義可能なグループで、一般的には異なるク

ラス間にまたがった共通フィールドが定義されます。 たとえば、特定のアプリケーションに影

響を与える異なる管理対象デバイスからのイベントは、同じグループ設定を持つでしょう。 

RULE そのタイプのアラームを指定されたイベントを発生させたルール名（例、ScheduledCheck）。

たとえば、Linux Agent クラスの空メモリ量を示すイベントは free_memory というルールを持

ちます。 

HRL Hierarchical Resource List （階層リソースリスト）： T1 から T3 と N1 から N3 の一連の名

前と値のペア。これらのフィールドはアラートの発生源を表します。各レベルはタイプのフィー

ルドと値のフィールドを持ちます。各イベントに対し、できるだけ具体的にHRL は影響を及ぼ

したコンポーネントを表します。たとえば、特定のカードとポートに使用するネットワークコン

ポーネントからイベントを受けた場合、その HRL は下記のようになるでしょう： 

T1 – Host N1 – 192.168.1.200 

T2 – Card N2 – A 

T1 – Port N1 – 101 

COUNT 同じクラス、ルールと HRL のイベントの繰り返し回数。繰り返しアラームが発生した場合、メ

ディエータ（mediator）がこのカウントを増やすか、新しいアラームを作成するかを決定します。

SEVERITY １（最高）から５（最低）までの重大度のランク付け。アラームの色が重要度（severity）を示

します。 デフォルト色は 赤 (severity 1) 、オレンジ  (severity 2) 、 黄色 (severity 3) 、LT

グリーン(severity 4) と 緑 (severity 5) です。 レポートフィルタのオプションにもイベント重

大度（All、1-5, と <3、 <4、 <5 ）があります。 

PRIORITY 1 から 99 (最低) までのイベントの優先度ランク付け 

FIRST TIME  Tap In 管理サーバによってイベントを受け取られた最初の時間（例、Fri Jan 16 14:25:13 2009）.

LAST TIME Tap In 管理サーバによってイベントを受け取られた最後の時間 (例、Fri Jan 16 16:50:14 2009).

EVENT ID イベントのユニークな識別子 (例、 ...5, 4, 3, 2, 1). 

ASTO アサイン先の ID – イベントにアサインされたコンシューマ（consumer ）名 (例. peter). 

RTTO 振り先の ID - – イベントの振り先とされたコンシューマ（consumer ）名 (例. peter). 

STATUS イベントのステータス。 管理サーバがどのようにそのイベントを処理するかを示すのに使用さ

れる単一文字指標の組み合わせでも可。 

MESSAGE (TEXT) イベントに付随するテキストメッセージ (例. CRITICAL – 10.254.34.192: rta nan, lost 

100%|rta=0.000ms; 200.000;600.000;0; pl=100%;80;100;;). 

GA レポートプログラムがグラフ化するアイテムとして翻訳するグラフのアトリビュート 

 (例 rta;pl). 

GV レポートプログラムが GA と結び付けてグラフ化する値や数値として、翻訳するグラフの値 

 (例. 0.000;100). 

Configuration Management 
Instance 
（構成管理インスタンス） 

Tap In管理サーバ上にプッシュおよび導入が可能な、使用権のあるユーザやアクティ

ブチェックを含む、構成定義。同時にひとつのみのインスタンスが稼動中でアクティ

ブとして導入できますが、複数のインスタンスをあらかじめ定義できます。たとえば、

変更実施期間中に、あなたの管理インフラストラクチャにシステムを追加したい場合、

新しいシステムのための監視定義を含む新しいインスタンスをあらかじめ定義できま

す。あなたの変更を導入後、Tap In 管理サーバ上にあらかじめ定義されたインスタン
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スを導入することができます。 

Consumer 
（コンシューマ） 

特別目的の管理機能のために Tap In 管理サーバのイベントを使用するプログラム。

Tap In の QuickView コンソールはコンシューマプログラムです。 

Event 
（イベント） 

Tap In 管理サーバシステムが表出してQuickView や Tap In Web ビューアで表示さ

れる、実世界の状況を表す抽象的な断面情報。 アラームは、sverity、priority、text 
messageと ID 番号などの識別アトリビュートを持ちます。イベントは、用語「アラ

ーム」と相互に置き換えて使用できます。 

Event Bus 
（イベントバス） 

メディエータからイベントを受け取り、コンシューマにイベントを送るのに責任を持

つ、 Tap In 管理サーバシステムのコンポーネント。これは、独立した Java アプリ

ケーションです。 

Event Display 
（イベント画面） 

Tap In 管理サーバシステムのイベントを詳しい一行目毎の形式で表示する 
QuickView アプリケーションのメインウィンドウです。 

Filter 
（フィルタ） 

ユーザにイベント表示をする前に選別するため使用する Structured Query Language 
(SQL) の仕様書あるいは、ステートメント。 SQL ステートメントは、QuickView の
ユーザによって定義と保存され、その後カレントのイベント画面に適用されます。  

Mediator 
（メディエータ） 

機器やシステムのステータスを監視し、Tap In 管理サーバシステムにイベントを送信

するプログラム。 

Open and Closed Events 
（オープン中および、 
クローズ済イベント） 

Open（オープン中）状態のイベントは管理対象内での現在の問題を示し、運用担当者

にとって興味があるものです。 QuickView はオープン中のイベントのみを表示しま

す。オペレータは QuickView を使って、イベントを選んで c lose アクションを選択

することで、オープン中イベントをクローズできます。Closed（クローズ済）イベン

トは、Tap In 管理サーバシステムのデータベースに保存されます。 

Perl システムの検査、および情報の取り出しのため、管理ツールで使用するのに最適化さ

れた、インタプリタプログラム言語。ほとんどの Tap In メディエータはPerl スクリ

プトを使って作成されています。 

QuickView Tap In 管理サーバシステムのデータを人が判読できるカラーコード化した監視イベ

ントに変換する Tap In のデスクトップソフトウェアのアプリケーション。 

Ruby Webアプリケーション開発ために一般的に使用されるインタプリタプログラム言語。

Tap In System の Web レポートは Ruby と Ruby-on-Rails で作成されています。

Ruby-on-Rails Ruby プログラム言語を土台にした Web アプリケーションフレームワーク。 
Ruby-on-Rails はインターネットの Web アプリケーション開発に広く利用
され、速い開発機能を提供します。Tap In System の Web アプリケーショ
ンは Ruby と Ruby-on-Rails を使って開発されています。 

Severity and Attribute 
Sparklines 

（重大度と 

アトリビュートの 

スパークライン） 

Sparkline（スパークライン）の用語は、Edward Tufte のよって、小さく、コンテキ

ストの用語、数字、イメージを組み込んだ高解像度のグラフのために提案されました。

Tufte は、スパークラインを、データに強く、シンプルなデザインの文字サイズのグ

ラフィックと述べています。標準的な図表できるだけ多くのデータを示すようデザイ

ンされ、文章の流れの中に置かれるのに対し、スパークラインは簡潔、覚えやすく、

それらが検討されるべき場所に置かれることを意図しています。 

Severity Timelines 
（重大度タイムライン） 

時系列グラフ上の位置としてイベントの重大度を表示するレポートのオプション。 

Tap In Cloud Management 
Service 
（Tap In クラウド管理サ

ービス） 

システムとアプリケーション監視と管理を可能にする Tap In Systems が提供するサ

ービス。そのサービスでは、Tap In 管理サーバへのアクセスと QuickView コンソー

ルやレポートなどの Tap In アプリケーションが提供されます。 

Tap In Management 
Server 
（Tap In 管理サーバ） 

Elastic Compute Cloud (EC2) インスタンスとして Amazon Web Service (AWS) ク
ラウド内で稼動する Tap In Systems のソフトウェア。 Tap In 管理サーバはシステ

ムや他の技術からのイベントをコンシューマプログラムで使うための中立な形式のイ

ベントストリームに変換します。 

Web Application 
（Webアプリケーション） 

Web で構成設定とレポーティングを提供する Tap In 管理サーバのコンポーネント。
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